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KENWOOD DVF-N7080 
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SID. 10 
 

ANSLUTNINGAR 
Alla anslutningar måste vara gjorda innan nätsladden sätts i uttaget. 
Enheten ansluts enligt nedan. 
Se även bruksanvisningarna till övriga anslutna komponenter. 
 
Mikrodatorn fungerar inte 
Om apparaten inte startar eller om displayen visar fel trots att alla anslutningar är korrekta, 
måste mikrodatorn ställas om (se sidan 48). 
  
Ansluta till TV-mottagarens videoingång 
Använd alltid kablar med RCA-kontakter som ansluts enligt teckningen. Speciella 
videokablar kan köpas i fackhandeln. 
Du får bara ansluta en av videokablarna – antingen den vanliga videokabeln eller den 
speciella S-kabeln (nederst på bilden). 
Om du ansluter med en ljudkabel måste du ställa om från ”Digital Audio” till ”PCM 
(Analog on)” på Setup-menyn (”Main”) enligt anvisningarna på sidan 18. 
 
Ansluta till TV-mottagarens SCART-ingång 
Använd alltid en SCART-kabel av god kvalitet.  
Om du ansluter med en ljudkabel måste du ställa om från ”Digital Audio” till ”PCM 
(Analog on)” på Setup-menyn (”Main”) enligt anvisningarna på sidan 18. 
Kontrollera att DVD-spelaren är ansluten direkt till TV:n och inte till en VCR, då det i 
sistnämnda fall finns risk för att bilden återges felaktigt på grund av kopieringsskyddet.  
 
Brus   
CD och DVD med DTS-kod ger störande brus vid uppspelning via analog stereoapparatur. 
Bruset kan skada komponenter i systemet. Dra därför ned volymen om du måste spela 
analogt. 
 
 
 
 
Sid. 11 
 
Ansluta till ljudutrustning 
Vid uppspelning av DTS-kodat ljud bör du endast ansluta till en AV-receiver eller AV-
förstärkare som kan avkoda DTS på digital väg. 
Anslutningen sker enligt bilden med optisk kabel eller koaxialkabel.  
Anslutningen till TV-mottagaren sker med video-, S-video- eller komponentvideokabel enligt 
anvisningar på sidan 10.  
 
Förstärkare med 2-kanals analog stereo eller Dolby Pro Logic II/Pro Logic: 
Anslut vänster och höger AUDIO OUT på DVD-spelaren till förstärkarens vänstra och högra 
IN-kontakter med audiokablar. 
Om du ansluter med en ljudkabel måste du ställa om från ”Digital Audio” till ”PCM 
(Analog on)” på Setup-menyn (”Main”) enligt anvisningarna på sidan 18. 
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Förstärkare med 2-kanals digital stereo (PCM) eller multikanaldekoder (Dolby Digital, 
MPEG 2 eller DTS): 
Anslut en av DVD-spelarens DIGITAL OUT-kontakter (Coaxial eller Optical) till 
motsvarande kontakt på förstärkaren. Använd en digital kabel (koaxial eller optisk). 
1. Om du ansluter en annan komponent, läs alltid igenom bruksanvisningen till denna före 

inkoppling. 
2. Om audioformatet på den digitala utgången inte är anpassat till din förstärkare eller 

receiver, kommer ljudet att återges med stark distorsion eller inte alls. 
3. Skjut alltid in den optiska fiberkabeln rakt i anslutningen tills du hör ett klickljud. 
4. Böj eller knäck aldrig en optisk fiberkabel. 
5. Ställ inte TV-mottagare eller andra tunga apparater på denna enhet. 
6. När en 96 kHz signal återges, kommer denna från DIGITAL OUT-anslutningen efter 

omvandling till 48 kHz. 
 
 
 
SID. 12 
 
Ansluta med Ethernet-kabel 
Anslut enligt bilden med Ethernet-kabel (finns att köpa i fackhandeln) via en router till 
modem resp. PC (Windows 2000 eller XP). 
Om du inte använder en router eller hub, anslut direkt till PC:n med en Ethernet-kabel. I detta 
fall måste IP-adressen ställas in manuellt (se sid. 20). 
OBS! Kontrollera i bruksanvisningen till router eller hub att denna tillåter anslutning med 
Ethernet-kabel (fungerar inte i sällsynta fall). 
 
Ansluta till en trådlös LAN 
Anslut med en trådlös Ethernet-brygga till Ethernet-teriminalen på baksidan enligt bild för att 
skapa en trådlös förbindelse. 
 
OBS! Denna enhet kan inte direktanslutas till Internet. 
 
 
SID. 13 
 

Kontroller och indikatorer 
Övre bilden visar displayens indikatorer. Från vänster är dessa  
REPEAT 1ALL A-B = repetition 
RANDOM = slumpmässig uppspelning  
PLAY = uppspelning  
PAUSE = paus  
TITLE = titel  
CHAP = kapitel  
TRACK = spår  
HOUR = timmar  
MIN = minuter  
SEC = sekunder  
P.B.C. (PLAYBACK CONTROL) = tillfällig från/till 
PROGRESSIVE = progressiv scanning  
FILE = fil  
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Information om skivtyp (ljud, bild, DVD, CD, VCD och DATA) 
 
Nedre bilden visar övriga indikatorer och kontroller: 
1. STANDBY = ansluten till nät  
2. Knapp för på/standby (ON/STANDBY) 
3. Öga för fjärrkontrollen – se sid. 14 
4. Skivladdning – se sid. 22 och 28 
5. Öppna/stäng – se sid. 22 och 28 
6. PC-kort – se sid. 43 
7. Utkast för PC-kort – se sid. 43 
8. Knapp för DVD/MEMORY-kort – se sid. 22, 28 och 43  
9. Knapp för NETWORK SERVER – se sid. 39 
10. Knapp för uppspelning/paus (PLAY/PAUSE) – se sid. 23, 29 och 40 
11. Stoppknapp – se sid. 23, 30 och 40 
12. Knappar för föregående resp. nästa spår – se sid. 23, 30 och 40 
13. Indikator för NET LINK 
 
 
STANDBY 
När indikatorn är tänd matas systemet med en grundström. Därmed kan systemet startas med 
fjärrkontrollen.  
 
FRÅNKOPPLING 
Om du vill stänga av strömtillförseln helt, trycker du på knappen ON/STANDBY. Efter 
ungefär 10 sekunder släcks standby-indikatorn och displayen. 
 
 
SID. 14 
 

Använda fjärrkontrollen  
Knappar på fjärrkontrollen med samma beteckningar som knapparna på huvudenheten har 
motsvarande funktioner. 
1. POWER = strömpåslag  
2. SETUP = inställningar (se sid. 17) 
3. Sifferknappar för programmering (se sid. 24 och 42) 
4. PAGE framåt/bakåt = bläddring (se sid. 29, 40 och 44) 
5. HOME = tillbaka till startsidan  
6. DVD/Memory Card (se sid. 22, 28 och 43)/NETWORK SERVER (se sid. 39) 
7. TOP MENU = för läsning av meny på DVD/P.B.C. = för tillfällig till-från-koppling vid 

uppspelning av VCD (se sid. 23 och 25) 
8. Pekare med upp, ner, vänster och höger (se sid. 17)/ENTER = programmera in (se sid. 17) 
9. RETURN = för bläddring i menyn (se sid. 17) 
10. ►/|| = uppspelning/paus (se sid. 23, 29 och 40)/|◄◄/►►| = snabbspolning (hoppa över) 

– se sid. 23, 30 och 40 
11. ◄◄/►►= snabbsökning framåt/bakåt (se sid. 23, 30 och 40)/■ = stopp (se sid. 23, 30 

och 40)/SLOW = uppspelning i slow-motion (se sid. 24) 
12. AUDIO = val av språk och/eller en kanal eller stereo (se sid. 25)/SUBTITLE = val av 

språk på textremsan (se sid. 25) 
13. REPEAT = repetition (se sid. 26, 31 och 41)/A-B = repetition av visst avsnitt (se sid. 26) 
14. VIDEO OUT = video ut (se sid. 8) 
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15. DIMMER = inställning av ljusstyrka (se sid. 3) 
16. SEARCH = sökning (se sid. 42) 
17. CLEAR = radera (se sid. 24, 32 och 42) 
18. Används inte på denna enhet 
19. MOVIE = film (se sid. 29 och 39)/MUSIC = musik (se sid. 29 och 39)/PHOTO = stillbild 

(se sid. 29, 39 och 43) 
20. MENU = meny (se sid. 23) 
21. ON SCREEN = display på skärmen (se sid. 27, 32 och 45) 
22. ANGLE = inställning av bildvinkel genom rotering (se sid. 27, 31 och 45)/STEP = stegvis 

frammatning (se sid. 24) 
23. RANDOM = slumpmässig uppspelning (se sid. 26)/ZOOM = zoomning i bilden (se sid. 

31, 41 och 45) 
 
 
SID. 15 
 
Installation av Kenwood PC Server 
Sedan du installerat Kenwood PC Server i din PC kan du importera data som lagrats i PC:n 
till biblioteken. I och med detta kan du lyssna och titta på musik, filmer och stillbilder. Men 
först måste du förstås ansluta PC:n till denna enhet och göra erforderliga inställningar (se sid. 
12 och 20). 
 
Minimikrav 
Operativsystem: Windows XP Professional SP1, Windows XP Home Edition SP1, Windows 
2000 Professional SP4 eller senare. 
OBS! Till varje system krävs installation av Service Pack. 
PC: IBM PC/AT kompatibel med något av ovanstående program. 
CPU: Intel Pentium III, 800 MHz eller större. 
Minne: 128 MB eller mer. 
Hårddiskutrymme: 160 MB eller mer. 
Ethernet interface: 100Base-TX rekommenderas. 
Antal DVF-N7080 enheter som kan anslutas till nätverket: 3 st. 
Tillverkaren kan inte garantera att enheten fungerar i alla miljöer även om dessa motsvarar 
ovanstående krav. 
Uppspelningen kan drabbas av upprepade avbrott när 10Base-T används som Ethernet 
interface eller IEEE802.11b används som trådlös Ethernet-brygga. 
 
Innan du börjar använda mjukvaran måste den installeras på PC:n enligt följande: 
Avsluta alla program. 
Kontrollera att PC:n arbetar enligt ovan. 
Programmet installeras automatiskt när enheten börjar användas. 
 
OBS! Logga in med det användarnamn som administratören tilldelat. 
 
 
1. Stoppa i ”KENWOOD PC SERVER Installation CD-ROM” i datorns CD-spelare. 

Installationen startar automatiskt och du uppmanas att välja språk. Därefter visas 
installationshjälpen. 
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• Om installationen inte startar dubbelklickar du på ”Min dator”-ikonen och därefter på CD-
ROM-spelaren. Du kan också starta installationen genom att dubbelklicka på filen 
”SETUP.EXE”. 

 
2. Fortsätt installationen enligt anvisningarna på skärmen. 

 På skärmen visas i tur och ordning: 

      [License Agreement] 
      [Choose Components] - välj komponenter 
      [Choose Install Location] - välj plats för installationen 
      Normalt installeras foldern i ”Programfiler”. Vill du ändra detta, välj annan plats med      
      musen.  
     [Java2 Runtime Installer] 
     [KENWOOD PC SERVER Installer] 
     [Completing the KENWOOD PC SERVER Setup Wizard] - avslutar installationen 
 
3. Starta om datorn 

 Följande moduler läggs till vid installationen: 

 Microsoft Data Access Components 2.5 

 Microsoft DirectX Media Runtime 

      Java 
• Om du avinstallerar programmet kommer dessa moduler att finnas kvar i datorn. 
 
KENWOOD PC SERVER 
Det är förbjudet att kopiera eller ändra i programmet. 
KENWOOD tar inget ansvar för skador orsakade av programmet. 
Specifikationerna kan ändras utan föregående meddelande.   
 
 
SID. 16 
 
Avinstallera Kenwood PC Server 
Innan du avinstallerar programmet måste du stänga alla fönster och program. 
  
Logga in med det användarnamn som tilldelats dig av programmet. 
 
1. Välj [Start] → [Control Panel] → [Add or Remove Programs] 
2. I dialogrutan [Change or Remove Programs] väljer du [Kenwood PC Server] och klickar 

på [Change/Remove] 
• Du kan också avinstallera genom att välja [Program] → [Kenwood PC Server] och 

därefter klicka på [Uninstall]. 
3. Följ sedan anvisningarna på skärmen för att genomföra avinstallationen. 
• Även efter avinstallationen kommer data att finnas kvar i Kenwood-mappen. Om du vill ta 

bort hela programmet måste du därför även radera ”Kenwood”-mappen. 
 
Installera nytt program 

     Avinstallera enligt ovan, starta om datorn och installera det nya programmet. I annat fall 
kommer det nya programmet inte att fungera korrekt. 
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Uppdatera Kenwood PC Server 
     Senaste information för uppdatering finns på nätet under rubriken ”Technical 

Support/Service”. 
• För att kontrollera installerad version väljer du [Help]→[Version Information]. 
 
1. Avinstallera aktuell Kenwood PC Server och Java 2 Runtime, starta sedan om datorn. 
2. Ladda ner senaste version av Kenwood PC Server och Java 2 Runtime. 
3. Installera den nya versionen enligt anvisningarna på sidan 15. 
 
 
 
SID. 17 
 
Inställningar 
 
Meny 
Grundinställning 
Med ”Setup”-menyn kan du göra olika justeringar. Dessa beskrivs i detalj på sidorna 18–20. 
 
Allmänt 
1. Slå på strömmen med knappen märkt POWER.  

Det tar några sekunder innan apparaten kan användas. 
2. Tryck på knappen SETUP. 

I läge uppspelning eller paus, tryck på knappen STOP. 
3. Använd knapparna ”upp/ned” på fjärrkontrollen för att välja önskad inställning och 

tryck sedan på ENTER för att gå till nästa steg. 
4. Använd knapparna ”upp/ned” på fjärrkontrollen för att genomföra nästa steg och 

tryck på ENTER för att gå till nästa.  
 
     Bilderna i högerspalten visar aktuella knappar på fjärrkontrollen och menyerna på 

skärmen.  
• För att avsluta tryck på RETURN eller på knappen ◄ på fjärrkontrollen. Du kan också 

välja ”BACK” på menyn och sedan trycka på ”ENTER”. 
 
De olika inställningarna i nivå 2 och möjliga parametrar. 
• För att återgå till föregående nivå, tryck på ”RETURN” eller på knappen ◄ på 

fjärrkontrollen. Du kan också välja ”BACK” på menyn och sedan trycka på ”ENTER”. 
 
 
SID. 18 
 
”Main” (huvudmeny) 
 
Menyspråk 
Välj språk för ”Setup”-menyn. 
 
Välj TV-format 
Du kan välja mellan  
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4:3 Letterbox – används vid anslutning till en standard-TV. Menyn återges med band uppe 
och nere i bildrutan. 
4:3 Panscan – används vid anslutning till en standard-TV. Menyn fyller hela bredden och 
beskär de delar som inte får plats. 
16:9 – används vid anslutning till bredbilds-TV.  
 
Video Out 
Anslut till videoutgången VIDEO OUT och välj aktuellt bildformat. Tabellen på sidan 18 
visar 9 olika kombinationer av videoformat. 
När inställningen vid DVD-videouppspelning är 480p, 720p eller 1080p, kommer det att stå 
”5 PAL, CVBS & YcbCr” på skärmen. 
 
Digitalt ljud (Digital Audio) 
Välj format ”Digital Audio” på menyn.  
 
Bitstream (Analog off): Välj denna inställning ifall du ansluter DVD-spelarens DIGITAL 
OUT-terminal till en förstärkare eller annan utrustning med en Dolby Digital eller DTS 
dekoder.  
 
PCM (ANALOG ON): Välj denna inställning vid anslutning till en tvåkanals digital 
stereoförstärkare. DVD-skivor som är kodade med Dolby Digital eller MPEG kommer 
automatiskt att konverteras till tvåkanals PCM-ljud. 
Välj ”PCM” när du inte ansluter till en AV-receiver eller förstärkare. 
 
Screen Saver 
Denna har två lägen – på eller av (ON/OFF). Vid läge ON kopplas strömspararen in efter ca 5 
minuter om apparaten står i läge STOP. 
 
Auto Power Save 
Denna har två lägen – på eller av (ON/OFF). Vid läge ON kopplas slås apparaten av 
automatiskt efter ca 60 minuter om apparaten står i läge STOP. 
 
Firmware Update – se sidan 47. 
 
Två system för att återge TV-bilden 
För att återge bilden på TV-skärmen används två olika system, dels ”Progressive scan” och 
dels ”Interlace scan”. Enligt sistnämnda system avkänns endast de udda linjerna i en ruta och 
därefter de jämna linjerna i nästa ruta. Vid användning av ”Progressive scan” scannas linjerna 
uppifrån och ned. På så sätt blir det mindre flimmer än med det andra systemet. 
Siffrorna anger antalet scannade linjer, till exempel 
720P = 2 ”Progressive scan” med 720 effektiva linjer 
1080i = ”Interlace scan” med 1080 effektiva linjer 
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SID. 19 
 
”DVD Player” Setup (DVD-spelaren) 
 
På skärmen visas följande rubriker: 
Disc Menu Language – välj menyspråk 
Audio Language – välj önskat språk på ljudspåret 
Subtitle Language – välj önskat språk på textremsorna 
 
Original: Anger på vilket språk skivan spelats in. 
 
Other: För att välja ett annat språk, använder du sifferknapparna och trycker sedan på 
ENTER för att programmera in önskad språkkod (se sidan 21). Skulle du råka slå in fel kod, 
tryck på CLEAR. 
OBS! I vissa fall har språket på skivan prioritet över det språk du väljer. 
 
Rating 
Med denna inställning kan du förhindra uppspelning av vuxenprogram som inte bör ses av 
barn. Om DVD-skivan är märkt ”Adult-oriented” eller motsvarande, kan du dock inte 
förhindra uppspelning annat än om det finns en sådan spärr inspelad på själva skivan  
 
Spärrar 
Nivå 8: Alla DVD kan spelas (inställning från tillverkaren) 
Nivå 7 till 2: Tillåter uppspelning av DVD avsedda för vuxna och barn (dock inte 
”vuxenfilmer”). 
Nivå 1: Bara barnprogram kan spelas. 
 
Byta lösenord 
Du kan skriva in eller byta lösenord på följande sätt: 
1. Välj ”Change Password” på ”Rating”-menyn och tryck sedan på ”ENTER”. 
2. Skriv in det gamla lösenordet och tryck sedan på ”ENTER”. 
3. Skriv in den nya fyrsiffriga koden och tryck på ”ENTER”. 
4. Tryck på knappen ”SETUP” för att stänga menyn. 
 
VCD P.B.C. 
”Playback Control” (P.B.C.) kan ställas i lägena ON eller OFF (se sidan 21). 
On: Video-CD med P.B.C. spelas upp enligt P.B.C.   
Off: Video-CD med P.B.C. spelas upp på samma sätt som ljudskivor. 
 
OBS! Funktionen kan stängas av eller kopplas in tillfälligt med hjälp av knappen märkt  
P.B.C. på fjärrkontrollen (se vidare sidan 25).   
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SID. 20 
 
IP Setup 
Vid anslutning till ett nätverk tilldelas alla anslutna en IP-adress som används för att 
identifiera datorn.  
Vanligen behöver du bara ansluta till nätverket för att erhålla en egen adress, men om detta 
inte sker automatiskt måste du ställa in adressen manuellt. Bekräfta alla adresser i nätverket 
och välj sedan en adress och subnet mask som ingen annan har.  
Från fabrik har enheten tilldelats denna adress: 
IP-adress: 192.168.1.1 
Subnet mask: 255.255.255.0 
För IP-adresser rekommenderas serier från 192.168.1.1 till 192.168.255.255 och för subnet 
mask 255.255.255.0. 
 
Erhålla en adress 
Auto: Med denna inställning erhåller du automatiskt en IP-adress och all övrig information. 
Manual: Kräver manuell inställning. 
När du valt ”Manual”  kan du manuellt ställa in IP-adress och subnet mask. 
 
För att bekräfta IP-adressen på en PC (gäller Windows XP) gör du så här: 
1. Logga in med tilldelat användarnamn. 
2. Välj [Start] → [Control Panel] → [Network and Internet Connections] → [Network 

Connections]. 
3. Högerklicka på [Local Area Connection] och välj [Properties]. 
4. Välj [Internet Protocol (TCP/IP)]. 
5. Klicka på knappen [Properties]. 
 
Bekräfta IP-adresserna till övriga datorer på samma sätt.  
 
För att skriva in en IP-adress gör du så här: 
1. Välj ”IP Adress” på IP-menyn och tryck sedan på ENTER. 
2. Skriv in IP-adressen och tryck sedan ENTER. 
3. Tryck på SETUP för att avsluta. 
 
OBS! Ställ in IP-adressen till denna enhet så att den inte blir densamma som till en annan 
dator. Exempel: 
PC: 192.168.1.2 
Denna enhet: 192.168.1.1 
 
Subnet Mask 
Skriv in denna så här: 
1. Välj ”Subnet Mask” på IP-menyn och tryck sedan ENTER. 
2. Skriv in Subnet Mask och tryck på ENTER. 
3. Tryck på SETUP för att avsluta. 
 
MAC-adress 
Denna kan inte ändras. 
OBS! Om innehållet i SETUP-menyn har ändrats, slå av strömmen och slå på den ingen.   
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SID. 22 
 
Uppspelning av DVD-Video, CD-DA eller VCD-skiva 
 
Vanlig uppspelning 
 
Förberedelse 
Slå på strömmen genom att trycka på knappen ON/STANDBY på DVD-spelaren. 
 
1. Lägg i en skiva.  

Tryck på knappen för öppning. Lägg i skivan med etiketten upp och stäng facket. 
 

2. Om spelarens programväljare (INPUT SELECTOR) inte står på DVD, trycker du 
på DVD/MEMORY CARD på fjärrkontrollen. 
Om programväljaren står på DVD, visas texten ”READING” på skärmen. Därefter visas 
data för skivan. 
I stället för att trycka på knappen DVD/MEMORY CARD på fjärrkontrollen, kan du göra 
inställningen på följande sätt: 
1. Tryck på knappen RETURN på fjärrkontrollen och välj ”SELECT INPUT”-menyn.        
2. Välj ”DVD” på menyn med ▲/▼-knapparna på fjärrkontrollen och tryck sedan på 

knappen ENTER. 
 
3.   Starta uppspelningen, antingen med knappen på spelaren eller fjärrkontrollen. 

• När du trycker på startknappen och skivfacket är öppet, kommer detta att stängas 
automatiskt och uppspelningen att börja. 

• Knappen INPUT SELECTOR måste stå i läge ”DVD” för att uppspelning ska kunna 
ske. 

      Om det handlar om en interaktiv DVD, visas en meny på skärmen. Tryck då på ”ENTER”     
      för att välja önskad meny.  
 
Bilden till vänster visar numren på titlar, kapitel och spår samt tid. 
Om DVD:n har en inspelad meny, kommer denna att visas när du trycker på knappen ”TOP 
MENU” eller ”MENU”. Välj sedan med pekaren.   
 
För att avbryta uppspelningen, tryck på STOP-knappen på spelare/fjärrkontroll. 
 
För att göra en paus i uppspelningen, tryck på paus-knappen ►/|| på spelare/fjärrkontroll. 
 
För att hoppa över kapitel eller spår, tryck på endera  |◄◄/►►|-knappen. 
• När du trycker på knappen hoppas spåret över och nästa spår spelas upp från början. 
• När du trycker en gång på knappen |◄◄, spelas kapitlet eller spåret upp ännu en gång. 
• Når du trycker flera gånger på knappen |◄◄, börjar uppspelningen från föregående 

kapitel eller spår. 
 
För att söka ett visst spår, tryck på endera ◄◄/►►-knappen. 
• Varje knapptryck ändrar sökhastigheten enligt följande: 

Framåt 8x eller bakåt 8x 
Framåt 16x eller bakåt 16x (endast DVD och VCD) 
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Framåt 32x eller bakåt 32x (endast DVD och VCD) 
Framåt 48x eller bakåt 48x (endast DVD och VCD) 

• För att återgå till vanlig uppspelning, tryck på knappen ►/||. 
 
 
SID. 24 
 
”STEP” (frysning av bild och visning ruta för ruta)  
Tryck på knappen märkt STEP på fjärrkontrollen. Vid varje tryck matas en ruta fram (gäller 
endast DVD och VCD). För att återgå till vanlig uppspelning trycker du på ►/||. 
 
Uppspelning i slow-motion 
Tryck på knappen märkt SLOW. För varje tryck ändras hastigheten enligt följande:  
Slow ½ 
Slow ¼ 
Slow 1/8 
För att återgå till vanlig uppspelning trycker du på ►/||. 
 
Uppspelning av önskat spår, kapitel eller titel 
Tryck på sifferknapparna på fjärrkontrollen för att programmera in spåret etc., tryck sedan på 
ENTER.  
DVD-Video: Titel väljs med spelaren i stopp-läge. Kapitel väljs under uppspelning. 
CD, VCD (med P.B.C. urkopplad): Spåret väljs. Exempel: För att välja spår 23, tryck 2 och 
3 och sedan ENTER.  
 
Uppspelning av en titel, ett visst spår eller kapitel, alternativt uppspelning under en viss 
tidslängd 
1. Under uppspelningen trycker du på SEARCH-knappen på fjärrkontrollen. 
2. Använd upp/ned-knapparna för att välja tid, titel, kapitel etc. 
3. Använd sifferknapparna för att skriva in tidslängd eller nummer och tryck sedan på 

ENTER. 
Ett exempel på display vid DVD-Video visas på bilden.  
• Råkar du skriva fel siffror, tryck då på CLEAR och börja om.  
OBS! Sök-funktionen (SEARCH) fungerar inte vid stopp eller då slumpmässig uppspelning 
(RANDOM) har valts. 
 
 
 
SID. 25 
 
Olika uppspelningsfunktioner 
 
Välja språk (DVD) 
Om en skiva har ljudspår på olika språk, kan du använda AUDIO-knappen på fjärrkontrollen 
för att tillfälligt ändra DVD-spelarens ljudinställning. Under uppspelningen trycker du på 
knappen AUDIO för att byta språk. Detta ändras för varje tryck.  
• Displayen släcks om du inte trycker inom 3 sekunder. 
Möjligheten att välja språk förutsätter att det finns flera ljudkanaler inspelade på skivan. 
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Välja ljudkanal (VCD) 
Du kan välja att spela upp endera ljudspåret eller båda för stereoeffekt. Tryck på knappen 
”AUDIO” på fjärrkontrollen. För varje tryck ändras inställningen enligt följande: 
”AUDIO L” = vänster kanal 
”AUDIO R” = höger kanal 
”AUDIO L+R” = vänster och höger kanal 
”STEREO”= stereoåtergivning 
 
Välja språk i textremsan (DVD) 
Under förutsättning att skivan har textremsor på olika språk kan du byta till önskat språk 
genom att trycka på knappen SUBTITLE på fjärrkontrollen, under uppspelningen. Varje gång 
du trycker på knappen ändras språket.    
• Displayen släcks om du inte trycker inom 3 sekunder. 
OBS! På en del skivor finns en textmeny inspelad. 
 
Använda P.B.C. (Playback Control, VCD) 
För att koppla in eller ur funktionen används knappen TOP MENU/P.B.C. på fjärrkontrollen. 
Ett tryck kopplar in den, nästa tryck kopplar ur den etc. 
OBS! Inställningar på ”SETUP”-menyn ändras då du använder denna funktion (se vidare 
sidan 19). 
 
 
SID. 26 
 
Repetition (DVD, CD, VCD) 
Du kan repetera en viss titel, ett kapitel, ett spår eller en skiva flera gånger.  
• Vid uppspelning av DVD (visas på skärmen): 

”REPEAT CHAPTER” = repetera det kapitel som spelas. 
”REPEAT TITLE” = repetera den titel som spelas. 

• Vid uppspelning av CD/VCD (visas på skärmen): 
”REPEAT TRACK” = repetera det spår som spelas. 
”REPEAT DISC” = repetera hela skivan. 

 
Under uppspelningen trycker du på knappen REPEAT på fjärrkontrollen. För varje tryck  
ändras inställningen enligt följande: 
 
Vid uppspelning av DVD (visas på skärmen): 
1. ”REPEAT CHAPTER” = repetera kapitel 
2. ”REPEAT TITLE” = repetera titel 
3. ”REPEAT CLEAR” = kopplar ur funktionen 
 
Vid uppspelning av VCD (visas på skärmen): 
1. ”REPEAT TRACK” = repetera spår 
2. ”REPEAT DISC” = repetera skivan 
3. ”REPEAT CLEAR” = kopplar ur funktionen 
 
Vid uppspelning av CD (visas på skärmen): 
1. ”REPEAT” och ”1” tänds = repetera spåret 
2. ”REPEAT” och ”ALL” tänds = repetera alla spår på skivan 
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3. Släcks = funktionen urkopplad 
 
• För att avbryta repetering, tryck på knappen REPEAT och välj ”REPEAT CLEAR” eller 

släck indikatorn på skärmen (enligt 3 ovan). 
• Om du trycker på SKIP (►►|) en gång under uppspelningen kopplas funktionen ur. 
• Repetering fungerar inte vid inställning P.B.C. (VCD) eller för vissa DVD (se sidan 19). 
 
A-B Repeat (repetera visst avsnitt, DVD) 
Med denna funktion kan du välja ut ett avsnitt som ska repeteras från A till B. 
 
1. Tryck på A-B-knappen på fjärrkontrollen för att välja scenens början. På displayen visas 

”A POINT SET” (startpunkten) som en bekräftelse. 
2. Tryck åter på A-B-knappen för att välja scenens slut. På displayen visas ”B POINT SET” 

(slutpunkten) som en bekräftelse.  
• För att koppla ur funktionen, tryck på knappen A-B. 
• Endast en titel kan repeteras på detta sätt. 
 
Slumpmässig uppspelning (Random Play, CD) 
Spåren på skivan spelas upp i slumpmässig ordning.  
Tryck på knappen RANDOM på fjärrkontrollen under uppspelningen.  
• Indikatorn ”RANDOM” tänds. 
• Varje gång du trycker på knappen kopplar du in eller ur funktionen. 
• När du trycker på knappen ►►| under uppspelningen, väljs ett annat spår och spelas upp 

slumpmässigt. 
 
För att avbryta den slumpmässiga uppspelningen trycker du på knappen RANDOM på  
fjärrkontrollen. Indikatorn släcks. 
För att upprepa funktionen, tryck en gång på knappen RANDOM på fjärrkontrollen. Varje 
gång du trycker på knappen kopplas funktionen in eller ur. 
• När alla spår på skivan har spelats, kopplas funktionen ur automatiskt. 
 
 
 
SID. 27 
 
Välja kameravinkel (DVD) 

     Vissa skivor innehåller scener eller sekvenser sedda ur olika kameravinklar. Om det bara   
finns en vinkel inspelad, fungerar inte funktionen. 
 
1. Under uppspelningen trycker du på knappen ANGLE på fjärrkontrollen.  
2. Välj kameravinkel genom att åter trycka på knappen. 
• Efter 3 sekunder stängs funktionen om du inte har tryckt på knappen. 
 
 
Zoom (DVD, VCD) 
Funktionen används för att förstora videobilden. Zoomning kan inte göras på alla DVD. 
Under uppspelningen trycker du på knappen ZOOM på fjärrkontrollen. 
För varje tryck ändras inställningen enligt följande: 
1. ”ZOOM 01” 
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2. ”ZOOM 02” 
3. ”ZOOM 03” 
4. ”ZOOM OFF” 
 
Display på skärmen (DVD, CD, VCD) 
Displayerna innehåller information om den aktuella skivan. För att koppla in displayen  
trycker du på knappen ON SCREEN på fjärrkontrollen sedan uppspelningen startats. 
 
DVD (se exempel på sidan 27) 
”Title”: aktuellt titelnummer 
”Chapter”: aktuellt kapitelnummer 
”Total Time”: tid som den aktuella titeln har spelats 
”Audio”: aktuellt ljudspår/tid för ljudspåret, valt språk och typ av ljuduppspelning 
”Subtitle”: aktuell text/språk och tid som gått sedan start 
”Angle”: nummer på kameravinkeln/totala antalet kameravinklar 
 
CD (se exempel på sidan 27) 
”Track”: aktuellt spårnummer/totala antalet spår 
”Track Time”: tid som den aktuella titeln har spelats 
”Total Time”: totala speltiden på skivan 
 
VCD (se exempel på sidan 27) 
”Track”: aktuellt spårnummer/totala antalet spår (visas vid inställning P.B.C.) 
”Track Time”: tid som det aktuella spåret har spelats (visas vid inställning P.B.C.) 
”Audio”: typ av ljuduppspelning (stereo, vänster och höger kanal eller vänster+höger kanal) 
”PBC”: ON eller OFF 
 
 
 
SID. 28 - 29 
 
Uppspelning av Data disc  
 
Vanlig uppspelning 
Slå på strömmen med knappen ON/STANDBY på huvudenheten.  
1. Lägg i en skiva (öppna facket, lägg i skivan och stäng facket). 
 
2. Om INPUT SELECTOR inte står på DVD, trycker du på knappen DVD/MEMORY 

CARD på fjärrkontrollen eller spelaren. Därefter visas texten ”READING” och sedan 
huvudmenyn. 

• I stället för att trycka på knappen DVD/MEMORY CARD kan du ställa om apparaten på 
följande sätt: Tryck på knappen RETURN på fjärrkontrollen för att få fram menyn 
”SELECT INPUT”. Använd pekarna för att välja ”DVD” och tryck sedan på ENTER. 

 
3. Välj typ av fil (se bild på sidan 29) 

Använd pekarna på fjärrkontrollen för att välja typ av fil (MOVIE, MUSIC eller PHOTO) 
och tryck sedan på ENTER. 
Du kan också välja genom att trycka på motsvarande knappar på fjärrkontrollen. 
• För att återgå till föregående meny använder du RETURN-knappen. 
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4. Välj en fil  

Tryck på upp/ned-knapparna på fjärrkontrollen för att välja fil. 
När du gjort valet, trycker du på ENTER. Då visas nästa nivå i mappen. 
Exempel på biblioteksmeny (se bild på sidan 29) 
”RETURN”-ikon: Tar dig tillbaka till huvudmenyn eller föregående meny. 
”HOME”-ikon: Tar dig tillbaka till dataskivans startmeny. 
”BACK”-ikon: Om du använt RETURN-knappen för att återvända till biblioteksvyn 
under uppspelning, kommer uppspelningen att avbrytas tillfälligt. För att starta den igen 
väljer du ”BACK”-ikonen. 
”PATH”-ikon: Visar sökvägen. 
 

5. Starta uppspelningen 
      För att gå till nästa sida: Tryck på knappen PAGE ▼. 
      För att gå till föregående sida: Tryck på knappen PAGE ▲       
 
Spara filer 
Se alltid till att programmet stängs på rätt sätt sedan du spelat in filer. I annat fall kan det 
hända att uppspelningen inte blir korrekt. 
• I vissa fall kan filnamnen komma att återges felaktigt beroende på vilket program som 

använts för att spara dem. 
• Skriv inte in mapp- eller filtyper som inte kan spelas upp på apparaten. 
• Skriv inte in fler än 10 sessioner på lagringsmediet. 
• Uppspelningen påbörjas först efter en stund om lagringsmediet är en multisessionsskiva. 
• I vissa fall går det inte att spela upp en skiva på vilken det lagrats såväl 

MP3/WMA/JPEG-filer (CD-ROM) som musikinformation (CD-DA). 
 
       
 
SID. 30 
 
För att avbryta uppspelningen, tryck på stopp-knappen på endera fjärrkontrollen eller 
spelaren. 
 
För att göra en paus i uppspelningen, tryck på paus-knappen på endera enheten. 
 
För att hoppa över filer (MOVIE, MUSIC, PHOTO), tryck på knapparna  |◄◄ (bakåt) 
eller ►►| (framåt) på endera enheten. 
• Filen före eller efter hoppas över och den valda filen spelas från början. 
• När du trycker en gång på |◄◄ under uppspelningen, kommer filen att spelas från början. 
 
Sökning (MOVIE, MUSIC): Tryck på knapparna ◄◄ (bakåt) eller ►► 
(framåt) under uppspelningen. 
• Tryck på knappen ►/|| på fjärrkontrollen för att återgå till vanlig uppspelning. 
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SID. 31 
       
Olika uppspelningsfunktioner (Data Disc) 
 
Repetition (MOVIE, MUSIC) 
En viss fil eller mapp kan repeteras. Tryck på knappen REPEAT på fjärrkontrollen under 
uppspelningen. För varje tryck ändras inställningen enligt följande (se bilderna på sidan 31): 
 
MOVIE (display på skärmen) 
1. ”REPEAT FILE” = repetera filen 
2. ”REPEAT FOLDER” = repetera mappen 
3. ”REPEAT CLEAR” = stänger av funktionen 
 
MUSIC (ikon) 
1. 1 = repetera fil 
2. F = repetera mapp 
3. Displayen släcks = funktionen urkopplad 
 
 
Zoom (PHOTO, endast JPEG) 
Tryck på knappen ZOOM på fjärrkontrollen under uppspelning. För varje tryck ändras 
inställningen enligt nedan: 
x1,25→x1,5→x1,75→x2→x2,25→x2,5→x2,75→x3→x3,25→x3,5→x3,75→x4→ZOOM 
OFF (urkopplad) 
 
För att rotera bilden (PHOTO, endast JPEG) 
trycker du på knappen ANGLE på fjärrkontrollen. För varje gång ändras inställningen enligt  
följande: 
1. ”ANGLE 1” = normal 
2. ”ANGLE 2” = 90º medsols 
3. ”ANGLE 3” = 180º medsols 
4. ”ANGLE 4” = 270º medsols 
• Om ingen inställning görs inom 3 sekunder, kommer displayen att släckas. 
 
 
SID. 32 
 
Uppspelning vid inställd tidpunkt (MOVIE, MUSIC) 
1. Under uppspelning, tryck på knappen SEARCH på fjärrkontrollen. 
2. Använd sifferknapparna för att skriva in tiden och tryck sedan på ENTER (se 

bilden).  
• Uppspelningen startar från den tidpunkt som ställts in. 
• Om du skriver in fel siffra, tryck på CLEAR och fortsätt skriva. 
• SEARCH-funktionen fungerar inte då apparaten står i stopp-läge. 
 
Display på skärmen  
Displayen innehåller information om den aktuella skivan. För att koppla in displayen  
trycker du på knappen ON SCREEN på fjärrkontrollen sedan uppspelningen startats. 
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MOVIE (se exempel på sidan 32) 
”File Name”: Aktuellt filnamn med sökväg 
”File Time”: Tid som den aktuella filen har spelats 
”File Size”: Storlek på den aktuella filen (inkl. totaltid) 
”Audio Quality”: Visar audio codec 
”Video Quality”: Visar video codec 
”---” visas när data inte kan identifieras 
 
MUSIC (se exempel på sidan 32) 
”File Name”: Aktuellt filnamn med sökväg 
”File Time”: Tid som den aktuella filen har spelats 
”File Size”: Storlek på den aktuella filen (inkl. totaltid) 
”Audio Quality”: Visar audio codec 
 
PHOTO (se exempel på sidan 32) 
”File Name”: Aktuellt filnamn med sökväg 
”File Size”: Storlek på den aktuella filen (inkl. totaltid) 
”Resolution”: Upplösningen hos den aktuella filen 
”Rotate Angle”: Rotera filen 
 
 
 
SID. 33 
 
KENWOOD PC SERVER 
 
Dubbelklicka på genvägsikonen för att koppla in Kenwoods PC Server.  
 
OBS! Inkoppling får endast göras en gång. 
 
Namn och funktioner på komponenterna i fönstret (se bilden sidan 33) 
1.  Mappfönster 
     Visar innehållet på datorns hårddisk. 
2.  Meny 
3. ↑ - knappen används för att gå till nivån ovanför den aktuella 

[SELECT ALL] = Klicka på knappen för att välja alla filer och mappar som visas 
[VIEW] = Klicka på knappen för att ändra format 
[EXPLORER]= Klicka på knappen för att öppna Windows Explorer-fönstret så att du kan 
se alla tillgängliga mappar. 

4. ”List window” = Visar innehållet i den valda mappen. 
5. [MOVIE] = Väljer ”MOVIE LIBRARY” (filmbibliotek) 

[MUSIC] = Väljer ”MUSIC LIBRARY” (musikbibliotek) 
[PHOTO] = Väljer ”PHOTO LIBRARY” (fotobibliotek) 

6. ”Library box” = Visar genrer och album i valt bibliotek 
7. ”Library list” = Visar innehållet i valt bibliotek 
8. [IMPORT] = Klicka på knappen för att importera valt innehåll till biblioteket 

[DELETE] = Klicka på knappen för att radera valda filer 
[DELETE ALL] = Klicka på knappen för att radera allt innehåll på bibliotekslistan 
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[▲] [▼] = Klicka på endera knappen för att flytta en fil och på så sätt ändra 
ordningsföljden vid uppspelningen (kan endast användas tillsammans med [MUSIC 
LIBRARY] eller [PHOTO LIBRARY].  
[BGM] = Klicka på knappen för att lägga till musik vid visning av stillbilder (kan endast 
användas tillsammans med [PHOTO LIBRARY] 
[SAVE] = Klicka på knappen för att spara data som enheten sedan kan använda vid 
sökning i biblioteket. 
 

VIKTIGT! Innan du stänger programmet måste du spara alla ändringar, då de i annat fall 
förloras.  

  
      
Använda menyn 
När du valt ett av menynamnen, visas en meny enligt följande. 
Om du valt [File] erbjuds följande alternativ: 
1. [Name Setting] – det fabriksinställda servernamnet är [PC Server 1]. Du kan byta ut det 

efter önskan (se bilden sidan 33). 
2. [Movie Folder Setting] – [Music Folder Setting] – [Photo Folder Setting] 

Ange sökväg till önskade mappar (upp till tre per bibliotek). Filerna importeras som 
”Temporary files”. 
Om du specificerar mappen som du använder för att spara TV-program i eller den som du 
vanligen använder som bibliotek, kan innehållet automatiskt importeras till servern. 
[Browse]: Klicka på [Browse] för att välja önskad mapp enligt förteckningen. 
Efter gjorda inställningar klickar du på [OK]. 

 
Importera MOVIE-filer som ”Temporary files” 
Bara innehållet i de översta mapparna importeras som ”Temporary”. De  
filer som ligger omedelbart efter importerade mappar kan spelas (se bilden sidan 33). 
På bilden ses överst en begärd mapp (Movie Folder Setting). Endast de tre översta filerna i  
denna kan spelas. 
 
 
SID. 34 - 35 
 
Importera MUSIC- eller PHOTO-filer som ”Temporary files” 
Bara innehållet i de översta mapparna importeras som ”Temporary”. Av schemat på sidan 34 
framgår vilka filer som kan spelas (”Playback possible”/”Playback impossible”. 
• För att importera PHOTO-filer öppnar du menyn, väljer [File]→[Save] och därpå [OK]. 

Du kan också klicka på [SAVE]. 
      [SAVE] = spara 
      [EXIT] = stäng 
 
Då du valt [VIEW]: 
1. [Stora ikoner] 
2. [Små ikoner] 
3. [Lista] 
4. [Detaljer] 
5. [Nytt träd] 
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Då du valt [CONVERT]: 
För att du ska kunna importera stillbilder till PHOTO-biblioteket måste du ställa in kopiering  
av filer. 
1. [High Quality] = inställning för hög upplösning 
2. [Normal] = standardinställning 
3. [Fast] = inställning som används för att konvertera till låg upplösning. Med denna 

inställning förkortas importtiden. 
 
Import av innehåll 
Innehållet i datorn kan importeras till valfritt bibliotek. För att välja bibliotek, klicka på  
[Movie], [MUSIC] eller [PHOTO]. 
Beträffande typer av data som kan importeras, se förteckningen på sidan 5 i den engelska  
bruksanvisningen. 
 
Importera till [MOVIE LIBRARY] 
Stora bilden på sidan 34 visar huvudmenyn. 
1. Välj genre (alternativen är [Action], [Drama], [Favorite] och [Sports]). 

Du måste välja en genre för att kunna fortsätta. 
2. Välj filminnehåll på mappmenyn så att det visas på listmenyn (se bild på sidan 34). 
3. Dra och släpp varje innehåll från listmenyn till biblioteksvyn. 

• Du kan i stället välja innehåll och därefter klicka på [IMPORT]. 
• Det är bara innehållet i mappens översta lager som kan överflyttas i steg 1 ovan. 
• Det är också möjligt att välja mer än ett innehåll och dra och släppa det samtidigt. 

 
4. Välj [File]→[Save] och klicka sedan på [OK]. 

• Du kan i stället klicka på knappen [Save]. 
 
 
Redigera [MOVIE LIBRARY] 
 
Lägga till en genrebox: 
Välj [MOVIE LIBRARY] och högerklicka på musen eller välj [ADD BOX]. 
• Skriv in namnet på genreboxen och klicka på [OK]. 
 
Ta bort en genrebox: 
Välj den box du vill ta bort och högerklicka på musen. När menyn  
visas väljer du [Delete Genre].  
• Du kan också välja [DEL BOX] för att ta bort en genrebox. 
 
Ge en genrebox ett nytt namn: 
Välj den genrebox du vill ge ett nytt namn och högerklicka på musen. När menyn visas väljer 
du [Modify Genre name]. 
 
Redigera bibliotekslistan 
 
Välja ett innehåll 
Välj det innehåll du vill ta bort och högerklicka på musen. När menyn visas väljer du [Delete 
Movie]. 
• Du kan också välja namnet på filmen och därefter [DELETE]. 
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Sortera innehåll 
Klicka på fliken för tilläggsinformation i biblioteksfönstret och välj aktuellt innehåll.  
 
Lägga till extra information 
Tilläggsinformation som visas i fönstret (”TITLE”, ”STARS” och ”YEAR”) kan redigeras. 
Dock kan vissa bokstäver inte användas. 
 
Importera innehåll till [MUSIC LIBRARY] 
Klicka på [MUSIC] för att gå till [MUSIC LIBRARY]. 
 
1. Välj genre eller album som du vill importera. 

I biblioteksrutan ser du genrerutorna i [MUSIC LIBRARY], till exempel [Classic], [Jazz], 
[Pop] och [Rock]. I varje genre kan det finnas albumrutor. 

• Du kan inte importera innehåll förrän du har valt genre eller album. 
 
2. Välj musikinnehåll som ska importeras i mappvyn så att det visas i listfönstret se 

bilden på sidan 35). 
 
3. Dra och släpp varje valt stycke från listfönstret till bibliotekets listfönster.  
• Du kan också välja innehåll och sedan klicka på [IMPORT]-knappen.  
 
 
SID. 36 
 
Importera valda mappar 
När du valt en genrebox i biblioteksrutan (längst ned till vänster), skapas en ny albumruta och 
innehållet i den mapp som du valt i bibliotekslistan (fältet överst till höger) importeras till 
albumrutan. (Albumet får nu samma namn som mappen.) 
När du väljer ett album i biblioteket (fältet längst ned till vänster), importeras innehållet i den 
valda mappen (från bibliotekslistan överst till höger) till albumet. 
 
Importera valda filer 
När du valt en genrebox i biblioteksrutan (längst ned till vänster), skapas ett nytt album och de 
valda innehållet i bibliotekslistan (överst till höger) importeras till albumet. (Samtidigt får 
albumrutan samma namn som mappen.) 
När du väljer ett album i biblioteket (fältet längst ned till vänster), importeras innehållet (från 
bibliotekslistan överst till höger) till albumet. (Du kan importera flera filer på en gång.)  
        
4. Välj på menyn [File]→[Save] och klicka sedan på [OK]. 
• Du kan också använda knappen [SAVE]. 
 
 
Redigera [MUSIC LIBRARY] 
 
Lägga till en genrebox: 
Välj [MUSIC LIBRARY] och högerklicka på musen eller välj [ADD BOX]. 
• Skriv in namnet på genren och klicka på [OK]. 
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Ta bort en genrebox:  
Välj ruta och högerklicka på musen. Eller välj  [Delete Genre] på menyn. 
• Du kan också ta bort en box genom att skriva namnet i rutan och därefter [DEL BOX]. 
 
Ge en genrebox ett nytt namn:  
Välj den box du vill ge ett nytt namn och högerklicka på musen. På menyn väljer du sedan  
[Modify Genre name]. 
 
Lägga till en albumbox: 
Välj ut den genrebox du vill lägga i albumboxen och högerklicka på musen. På menyn väljer  
du sedan [Add Album]. 
• Skriv in namnet på albumboxen och klicka sedan på [OK] för att lägga till den. 
 
Ge en albumbox ett nytt namn: 
Välj den box du vill ge ett nytt namn och högerklicka på musen. På menyn väljer du [Modify  
Album name]. 
 
Ta bort en albumbox: 
Välj den albumbox du vill ta bort och högerklicka på musen. På menyn väljer du [Delete  
Album]. 
• Du kan också skriva in namnet på boxen och sedan trycka på [DEL BOX]. 
 
 
Redigera bibliotekslistan 
 
Ta bort innehåll: 
Välj det innehåll du vill ta bort och högerklicka på musen. På menyn väljer du sedan [Delete  
Music]. 
• Du kan också skriva in namnet på innehållet och sedan välja [DELETE]. 
 
Sortera innehåll: 
Klicka på fliken med tilläggsinformation i bibliotekslistan för att sortera innehållet. 
• Detta påverkar inte listan i fönstret. 
 
Ändra ordningsföljd på uppspelningen: 
Välj ett innehåll i bibliotekslistan och klicka på [▲] eller [▼] för att flytta om innehållet  
uppåt eller nedåt. 
 
Lägga till extra information: 
Den extra information för varje album som visas i biblioteksvyn kan redigeras, till exempel 

”ALBUM”, ”ARTIST”, ”LABEL”, ”YEAR” och ”TITLE”.  
• Vissa bokstäver kan inte återges i bibliotekslistan. 
 
Om du tar bort ett musikinnehåll med länk till ”BGM” raderas inställningen för  
bakgrundsmusik.  
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SID. 37 
 
Importera innehåll i [PHOTO LIBRARY] 
Klicka på fliken [PHOTO] för att ta fram [PHOTO LIBRARY]. 
 
1. Välj genrebox eller albumbox för aktuellt innehåll. 

Biblioteksboxen visar de olika boxarna i [PHOTO LIBRARY], till exempel [2004],  
       [Family] och [MyPicture]. Varje genrebox kan rymma flera albumboxar. 

• Inget innehåll kan importeras förrän du valt en genrebox eller en albumbox. 
 
2. Välj aktuellt fotoinnehåll så att de visas i listfönstret och kan importeras till 

mappfönstret. 
 
3. Dra och släpp varje innehåll från listfönstret till bibliotekets listfönster. 

• Du kan också välja innehåll och sedan klicka på [IMPORT]. 
 
Importera valda mappar 
När du valt en genrebox i biblioteksrutan (längst ned till vänster), skapas en ny albumruta och 
innehållet i den mapp som du valt i bibliotekslistan (fältet överst till höger) importeras till 
albumrutan. (Albumet får nu samma namn som mappen.) 
När du väljer ett album i biblioteket (fältet längst ned till vänster), importeras innehållet i den 
valda mappen (från bibliotekslistan överst till höger) till albumet. 
 
Importera valda filer 
När du valt en genrebox i biblioteksrutan (längst ned till vänster), skapas ett nytt album och de 
valda innehållet i bibliotekslistan (överst till höger) importeras till albumet. (Samtidigt får 
albumrutan samma namn som mappen.) 
När du väljer ett album i biblioteket (fältet längst ned till vänster), importeras innehållet (från 
bibliotekslistan överst till höger) till albumet. (Du kan importera flera filer på en gång.)  
 
• När stillbildsdata importeras som innehåll, skapas automatiskt en ny fil i rätt storlek. Du 

bör därför vara uppmärksam på kapaciteten hos din hårddisk. Beroende på hur snabb din 
dator är kan det ta en stund innan konverteringen är genomförd. 

• När fotografiska bilddata i annat format än JPEG importeras, konverteras automatiskt 
kopieringsfilen till JPEG-format och rätt storlek. 

 
4. På menyn väljer du [File]→[Save] och klickar sedan på [OK]. 

• Du kan också klicka på [SAVE]. 
 
 
Redigera [PHOTO LIBRARY] 
 
Lägga till en genrebox: 
Välj [PHOTO LIBRARY] och högerklicka på musen eller välj [ADD BOX]. 
Skriv in namnet på boxen och klicka sedan på [OK]. 
 
Ta bort en genrebox: 
Välj den box du vill ta bort och högerklicka på musen. Välj [Delete Genre] på menyn. 
• Du kan också skriva in namnet på boxen och sedan välja [DEL BOX]. 
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Ge en genrebox ett nytt namn: 
Välj aktuell box och högerklicka på musen. Välj [Modify Genre name] på menyn.  
 
 
SID. 38 
 
Lägga till en albumbox: 
Välj ut den genrebox du vill lägga i albumboxen och högerklicka på musen. På menyn väljer  
du sedan [Add Album]. 
• Skriv in namnet på albumboxen och klicka sedan på [OK] för att lägga till den. 
 
Ge en albumbox ett nytt namn: 
Välj den box du vill ge ett nytt namn och högerklicka på musen. På menyn väljer du [Modify  
Album name]. 
 
Ta bort en albumbox: 
Välj den albumbox du vill ta bort och högerklicka på musen. På menyn väljer du [Delete  
Album]. 
• Du kan också skriva in namnet på boxen och sedan trycka på [DEL BOX]. 
 
   
Redigera bibliotekslistan 
 
Ta bort innehåll: 
Välj det innehåll du vill ta bort och högerklicka på musen. På menyn väljer du sedan [Delete  
Photo]. 
• Du kan också skriva in namnet på innehållet och sedan välja [DELETE]. 
 
Sortera innehåll: 
Klicka på fliken med tilläggsinformation i bibliotekslistan för att sortera innehållet. 
• Detta påverkar inte listan i fönstret. 
 
Ändra ordningsföljd på uppspelningen: 
Välj ett innehåll i bibliotekslistan och klicka på [▲] eller [▼] för att flytta om innehållet  
uppåt eller nedåt. 
 
Lägga till extra information: 
Den extra information för varje album som visas i biblioteksvyn kan redigeras, till exempel 

”ALBUM”, ”DATE”, ”BGM” och ”TITLE”.  
• Vissa bokstäver kan inte återges i bibliotekslistan. 
 
Länka BGM till SLIDE SHOW 
Innehållet i [MUSIC LIBRARY] kan länkas till innehållet i [PHOTO LIBRARY] och vald 
musik användas som bakgrundsmusik (BGM) under bildvisningen. 
• Fotofilerna och musikfilerna måste importeras till biblioteket i förväg.  
 
1. Klicka på fliken [PHOTO] för att gå till [PHOTO LIBRARY]. 
2. I biblioteksvyn väljer du det album du vill länka för bakgrundsmusik. 
3. Klicka på knappen [BGM]. 

Nu visas dialogrutan [Baclground Music setting]. 
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4. Välj det musikinnehåll du vill länka som bakgrundmusik till albumet. 
• Musikinnehållet kommer att spelas/repeteras tills bildvisningen är slut. 

5.  Gå till [File]→[Save] på menyn och klicka på [OK]. 
• Du kan också klicka på [SAVE]. 

  
 
 
SID. 39 
 
Uppspelning via Network Server 
Före anslutning måste du redigera eller ta bort innehåll med en KENWOOD PC Server.  
 
1. Om Input Selector inte står i läge NETWORK SERVER, tryck på knappen 

NETWORK SERVER på huvudenheten/fjärrkontrollen. 
I stället för att använda knappen NETWORK SERVER, kan du gå in på SELECT INPUT-
menyn och där välja NETWORK SERVER.  

 
2. Välj en server med upp/ned-knapparna på fjärrkontrollen och tryck därefter på 

ENTER. 
Bilden på sidan 39 visar varningsskylten då en server inte kan hittas. Med knapparna 
SETUP, CLOSE och RETRY kan du koppla tillbaka till inställningsfönstret, avbryta 
sökningen eller försöka igen. 
• Det kan ta en stund innan anslutningen till en NETWORK SERVER är klar. 
• Upp till 16 PC-servers kan loggas in. 

 
3. Välj filtyp med upp/ned-knapparna och tryck sedan ENTER.    

• Du kan också välja filtyp med knapparna MOVIE, MUSIC eller PHOTO på 
fjärrkontrollen. 

• Bilden längst ned på sidan 39 visar startfönstret för NETWORK SERVER.  
• När du väljer ”SETUP” får du fram inställningsfönstret. 
• Återgå till föregående fönster med knappen RETURN.  

 
 
SID. 40 
 
4. Välj en fil. 

Tryck på upp/ned-knapparna på fjärrkontrollen för att välja ett filnamn. 
När du har valt en mapp och trycker på ENTER, visas nästa nivå i foldern. 
• På sidan 40 visas ett exempel på en sida i biblioteksvyn. Använda knapparna PAGE 

upp eller PAGE ned för att gå till föregående respektive följande sida.  
 
5. Starta uppspelningen. 

Tryck på ENTER och sedan på ►/|| på huvudenhet eller fjärrkontroll. 
 

För att avbryta uppspelningen, tryck på stopp-knappen. 
 
För att hoppa över filer, tryck på |◄◄ eller ►►| på endera enheten. 
 
Sökning sker med knapparna ◄◄/►► på fjärrkontrollen. 
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För att återgå till normal uppspelning, tryck på ►/||.  
 
 

SID. 41 
 
Repetition (MOVIE, MUSIC) 
Du kan repetera en viss fil, mapp eller genre flera gånger.  
• ”REPEAT TITLE” = Repetera den titel som spelas (endast MOVIE). 
• ”REPEAT TRACK” = Repetera det spår som spelas (endast MUSIC). 
• ”REPEAT ALBUM” = Repetera en albumbox som spelas (endast MUSIC). 
• ”REPEAT GENRE” = Repetera en genrebox som spelas. 
 
Under uppspelningen trycker du på knappen REPEAT på fjärrkontrollen. För varje tryck  
ändras inställningen enligt följande: 
 
Vid uppspelning av MOVIE (visas på skärmen) 
1.   ”REPEAT TITLE” 
4. ”REPEAT GENRE” 
5. ”REPEAT CLEAR” (kopplar ur funktionen) 
 
Vid uppspelning av MUSIC (visas på skärmen) 
1   ”REPEAT TRACK” 
A  ”REPEAT ALBUM” 
G  ”REPEAT GENRE”  
     Släcks = stänger av funktionen 
 
• För att avbryta repetering, tryck på knappen REPEAT och välj ”REPEAT CLEAR” eller 

släck indikatorn på skärmen (enligt 3 ovan). 
• Om du trycker på SKIP (►►|) en gång under uppspelningen kopplas funktionen ur. 
 
Zoom (PHOTO) 
Används för att förstora en fotografisk bild under uppspelningen. 
Tryck på knappen ZOOM på fjärrkontrollen. För varje tryck ändras inställningen enligt  
nedan: 
x1,25→x1,5→x1,75→x2→x2,25→x2,5→x2,75→x3→x3,25→x3,5→x3,75→x4→ZOOM 
OFF (urkopplad) 
 
För att rotera bilder (PHOTO) 
Under uppspelningen trycker du på knappen ANGLE på fjärrkontrollen.  
För varje tryckning ändras inställningen enligt följande: 
1. ”ANGLE 1” = normal 
2. ”ANGLE 2” = 90º medsols 
3. ”ANGLE 3” = 180º medsols 
4. ”ANGLE 4” = 270º medsols 
• Om ingen inställning görs inom 3 sekunder, kommer displayen att släckas. 
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Slide show (PHOTO) 
Vid denna inställning matas bilderna fram en efter en helt automatiskt. 
1. Välj SLIDE SHOW-ikonen och tryck sedan på ENTER (se bilden på sidan 41). 
2. Välj ett ALBUM för att starta visningen och tryck sedan på ENTER. 
 
Längst ned på sidan 41 visas textinformation för MOVIE, MUSIC och PHOTO.  
 
 
SID. 42 
 
Uppspelning av en viss fil  
 
1. Tryck på knappen SEARCH på fjärrkontrollen när du ser biblioteksvyn. 

• Sökrutan visas på biblioteksvyn. 
 
2. Knappa in de tre första bokstäverna i den fil du söker med hjälp av knappsatsen på   

fjärrkontrollen (MOVIE, TITLE, MUSIC, TRACK, PHOTO, ALBUM). 
• Sifferknapparna 2 – 9 används för att skriva in de bokstäver som visas i tabellen 

nederst på sidan 42. 
• För att till exempel skriva in namnet ”Ken” trycker du två gånger på knapp 5, fem 

gånger på knapp 3 och fem gånger på knapp 6.  
 
3. Använd ”upp/ned”-knapparna på fjärrkontrollen för att välja SEARCH, och tryck 

sedan på ENTER.  
 
   
SID. 43 - 44 
 
Uppspelning av MEMORY CARD 
 
• På sidan 46 finns information om minneskort och kortadaptrar som kan användas 

tillsammans med denna enhet. 
• Endast JPEG-filer kan spelas. 
 
1. Sätta i ett minneskort 

Slå av strömmen. Sätt i kortet. Slå på strömmen. 
• Se alltid till att strömbrytaren står i läge OFF (STANDBY) innan du sätter i eller tar ut 

ett minneskort. 
• För att ta ut kortet, tryck på knappen EJECT och ta sedan ut kortet (se bild). 
 

2. Om INPUT SELECTOR inte är inställd på MEMORY CARD, tryck på knappen 
DVD/MEMORY CARD på huvudenheten eller fjärrkontrollen.  
• I stället för att trycka på knappen DVD/MEMORY CARD kan du använda SELECT 

INPUT-menyn på skärmen.  
Börja med att trycka på knappen RETURN på fjärrkontrollen för att ta fram menyn. 
Välj sedan ”MEMORY CARD” med pekaren och tryck ENTER.  
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3. Välja filtyp 
Välj PHOTO och tryck på knappen ENTER. Du kan också välja inställning genom att 
trycka på knappen PHOTO på fjärrkontrollen. 
Menyn visas på bilden på sidan 43.  
• Om minneskort eller kortadapter inte skjutits in eller skjutits in hela vägen, kommer          

startsidan inte att visas. I så fall slår du från strömmen (STANDBY-läge) och skjuter 
in minneskort eller adapter på nytt.  

            Displayen byts till SETUP om du trycker på SETUP. 
            För att gå tillbaka till föregående bild, tryck på RETURN på fjärrkontrollen.  
 
4. Välja mapp 

Tryck på ”upp/ned”-pilarna på fjärrkontrollen för att välja mapp. Tryck sedan på ENTER. 
Då visas nästa nivå i mappen. 
Exempel på meny (se bild på sidan 44) 
”RETURN”-ikon: Tar dig tillbaka till startsidan eller föregående meny. 
”HOME”-ikon: Tar dig tillbaka till minneskortets startsida. 
”PATH”-ikon: Visar sökvägen. 
För att visa nästa sida, tryck på knappen PAGE▼ 
För att visa föregående sida, tryck på knappen PAGE▲  

 
5. Tryck på knappen ENTER 
 
6. Starta uppspelningen 

Använd ”upp/ned”-knapparna på fjärrkontrollen för att välja fil. 
• Det kan ta en liten stund innan bilden visas beroende på hur stor filen är. 
• Om ingen bild visas, försök slå av och på strömmen en gång.  

 
För att avbryta uppspelningen, tryck på stopp-knappen. 
 
OBS! Endast minneskort och kortadaptrar som nämns på sidan 46 kan användas. Om du satt i 
ett kort av annan typ kommer systemet att stanna. Slå då av strömmen, ta ut kortet och slå på 
strömmen igen.  
 
   
SID. 45 
 
Hoppa över filer 
Tryck på knappen |◄◄ eller ►►| på spelaren eller fjärrkontrollen för att gå bakåt respektive  
framåt. 
 
Zoom 
Används för att förstora en fotografisk bild under uppspelningen. 
Tryck på knappen ZOOM på fjärrkontrollen. För varje tryck ändras inställningen enligt  
nedan: 
x1,25→x1,5→x1,75→x2→x2,25→x2,5→x2,75→x3→x3,25→x3,5→x3,75→x4→ZOOM 
OFF (urkopplad) 
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För att rotera bilden  
trycker du på knappen ANGLE på fjärrkontrollen. För varje gång ändras inställningen enligt  
följande: 
5. ”ANGLE 1” = normal 
6. ”ANGLE 2” = 90º medsols 
7. ”ANGLE 3” = 180º medsols 
8. ”ANGLE 4” = 270º medsols 
• Om ingen inställning görs inom 3 sekunder, kommer displayen att släckas. 
 
Display på skärmen 
Tryck på knappen ON SCREEN på fjärrkontrollen under uppspelning. Du får då upp en  
display så som visas på bilden på sidan 45 (vänstra spalten längst ned).  
”File Name”: Aktuellt filnamn med sökväg 
”File Size”: Storlek på den aktuella filen (inkl. totaltid) 
”Resolution”: Upplösningen hos den aktuella filen 
”Rotate Angle”: Rotera filen 
 
Lager som kan uppspelas 
Endast filer i mappar som finns i det andra lagret kan spelas (se bilden på sidan 45).  
 
 
SID. 47 
 
Uppdatering av Firmware 
Med Firmware menas uppdateringar som tillhandahålls av tillverkaren och kan hämtas  
från nätet. 
 
Anslutning sker till den server som laddat ned den uppdaterade filen och den aktuella datorn  
via LAN. Före uppdateringen måste alla fönster stängas. 
Inga andra operationer får företas samtidigt med hämtningen, som görs enligt följande: 
 
1. Slå på strömmen. 
 
2. Tryck på knappen NETWORK SERVER för att ställa in enheten. 
 
3. Välj den server som laddat ner uppdateringsprogrammet med hjälp av ”upp/ned”-

knapparna på fjärrkontrollen. Tryck sedan på ENTER. 
 
4. Tryck på knappen SETUP. 
 
5. Välj ”Firmware Update” på huvudmenyn (MAIN SETUP) och tryck sedan på 

ENTER. 
 
6. Välj ”UPDATE” på skärmen och tryck på ENTER. 

• För att avbryta välj ”CANCEL”. 
 
 
7. När du ser texten ”UPDATE OK”, startar du om apparaten genom att stänga och 

starta den igen med POWER-knappen. 
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De olika menyerna visas på bilderna på sidan 47. 
 
VIKTIGT: Innan du uppdaterar med Firmware måste du uppdatera mjukvaran till senaste 
versionen av KENWOOD PC SERVER. 
 
Senaste information om program och installation hämtar du på ”Technical Support/Service” 
på Kenwoods hemsida (en länk till den svenska versionen finns på www.kenwood.com). 
    
 
          

http://www.kenwood.com)/
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